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Safety

Read this section before installing and operating the Multiple Probe 215 Liquid Handler.

The Multiple Probe 215 Liquid Handler is intended to be used in a laboratory environment by trained 
technical personnel.

For safe and correct use of this instrument, it is recommended that both operating and service personnel 
follow the instructions contained in this guide when installing, cleaning, and maintaining the 
liquid handler.

The following safety precautions must be observed during all phases of operation, service, and repair of 
the instrument. Failure to comply with these precautions or with specific warnings elsewhere in this 
user’s guide violates safety standards of design, manufacture, and intended use of the liquid handler. 
Gilson assumes no liability for the customer’s failure to comply with these requirements. 

The Multiple Probe 215 Liquid Handler has been certified to UL, CSA, and CE Safety standards.
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The following electronic and hazard symbols may appear on the instrument:

Symbol Explanation

~

Alternating current

Courant alternatif

Wechselstrom

Direct current

Courant continu

Gleichstrom

Protective conductor terminal

Borne de terre de protection

Schutzleiteranschluss

|

Electrical power ON

Sous tension

Netzschalter ein

O

Electrical power OFF

Hors tension

Netzschalter aus

Caution

Attention

Vorsicht

Caution, risk of electric shock

Attention, risque de choc électrique

Vorsicht, Elektroschockgefahr

Caution, hot surface

Attention, surface chaude

Vorsicht, heiße Oberfläche

Fuse

Fusible

Sicherung

Keep hands clear of probe

Garder les mains éloignees de l'aiguille

Halten Sie Hände fein von der Nadel
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Safety

The following safety notices may appear in this document:

Voltage

Access to the rear panel is necessary. The liquid handler must be detached from 
all voltage sources before service, repair, or exchange of parts.

For normal operation, the liquid handler is to be grounded through the AC line 
cord provided. Failure to do so can result in a potential shock hazard that could 
result in serious personal injury.

Use only fuses with the rated current and of the specified type as listed on the 
rear panel of the instrument.

The instrument must only be operated with the voltage specified on the rear 
panel label of the instrument using a grounded AC line cord.

Probes

While operating the liquid handler, keep hands clear of probe to avoid risk of 
personal injury by piercing.

Because the probe installed on the Z-arm may contain a dangerous substance, 
do not interfere in the work area of the instrument until the liquid handler has 
completed its procedures. 

WARNING indicates a potentially hazardous 
situation which, if not avoided, may result in 
serious injury

CAUTION indicates a potentially hazardous 
situation which, if not avoided, may result in 
minor or moderate injury

NOTICE indicates a potentially hazardous 
situation which, if not avoided, may result in 
equipment damage
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Solvents

Observe safe laboratory practices when handling solvents. If dangerous liquids 
are used, adequate protection such as proper ventilation, safety glasses, etc., 
should be used.

Refer to the Material Safety Data Sheets for the solvents before use.

Replacement Parts

Be sure to use only original replacement parts, mentioned in Chapter 4, 
Maintenance and Appendix A, Replacement Parts and Accessories. Do not 
repair or change parts which are not listed in this user’s guide. If it is necessary to 
change parts not listed, please contact your Gilson-authorized representative. 
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Introduction 1

This chapter provides information on the following topics:

• Description

• Unpacking

• Customer Service

• Technical Specifications
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D
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The Multiple Probe 215 Liquid Handler is a high-throughput automated liquid 
handler capable of tasks such as sample transfers, dilutions, mixing, reagent 
addition, and microplate reformatting. It features patented Dual Rail™ syringe 
drive technology, accurate use of four or eight syringes, and accommodates 
probes that fit all application requirements. The Multiple Probe 215 
Liquid Handler is intended to be used in a laboratory environment by trained 
technical personnel.
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Unpacking

The liquid handler is delivered with all major components already assembled 
except for auxiliary parts such as the Z-arm, syringes, probes, racks, tubing, etc. 

The liquid handler and its components are shipped in two containers:

• One container holds the liquid handler. Keep this container and packing 
assembly in case the liquid handler must be returned to the factory.

• The other container holds the auxiliary parts and any additional accessories 
that you ordered for the liquid handler.

To remove the liquid handler from its container:

1 Grasp the free end of the strapping around the box. Pull away from the box. 
Be alert when it releases as the strapping is very taut. Repeat for the second 
piece of strapping.

2 Lift the outer box off and away from the liquid handler.

3 Lift the inner box off and away from the liquid handler.

4 Lift the unit off its base platform and place it on a lab bench or cart. 

Gilson recommends that two people lift the liquid handler off 
the base of the packing container. 

Do not attempt to lift the instrument from the Y-arm (the 
horizontal arm). Always lift the instrument from its base.

a) Using the two cutouts for hand holds, place a hand at the base of the 
packing container. 

b) Grip the liquid handler under the base plate.

c) Lift the unit up and out of the foam packing material. The side containing 
the electronics cabinet is the heavier side.
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After the liquid handler and accessories have been unpacked from their 
containers, you should have the following:

Multiple Probe 215 Liquid Handler (part number 25101311)

Z-arm (125 or 175 mm) and control cable with retaining clip

Locator plate with one drain base (includes 4 mounting screws)

Accessories which include:

• Rinse drain package which includes: 8-liter waste bottle, rinse station with 
fittings, and 5 feet of Tygon waste tubing with quick-connect fitting

• 8 PTFE inlet tubings (650 x 3 x 2 mm) with 20 μm stainless steel filter

• Cable support rod with bracket and 2 Phillips–head attachment screws

• Tubing support rod

• Fuse drawers, fuses, and power cords

• 10-pin terminal block

• 8-pin terminal block

• 10 plastic locking twist ties

• 9/64" ball driver for removal of armlock

• Spiral Wrap

215 Utility Programs CD

Documentation

The following documents are included with the Multiple Probe 215 
Liquid Handler.

• Multiple Probe 215 Liquid Handler Documentation CD

• Declaration of Conformity

• Installation Qualification/Operational Qualification Procedures
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Accessories

Based upon your configuration, you also ordered and received additional 
accessories, such as probes, syringes, transfer tubing, racks, and so on. If 
necessary, refer to Appendix A, Replacement Parts and Accessories for part 
numbers.
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Gilson, Inc. and its worldwide network of authorized representatives provide 
customers with the following types of assistance: sales, technical support, 
applications, and instrument repair.

If you need assistance, please contact your Gilson-authorized representative. 
Specific contact information can be found at www.gilson.com. To help us serve 
you quickly and efficiently, please refer to Before Calling Us on page 5-9.
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Technical Specifications

Please be aware of the following before operating the liquid handler.

Changes or modifications to the liquid handler not expressly 
approved by Gilson could void the warranty.

This instrument complies with part 15 of the FCC Rules. Operation is subject to 
the following two conditions: (1) this instrument may not cause harmful 
interference, and (2) this instrument must accept any interference received, 
including interference that may cause undesired operation.

Shielded cables must be used with the liquid handler to ensure compliance with 
the FCC Class A limits.

Technical Specification Definition

Arm Speed >45.7 cm/sec (>18 in/sec) in X dimension

>40.6 cm/sec (>16 in/sec) in Y dimension

Communication Interface RS-232 or GSIOC; Four inputs (contact closure, TTL, or 
open-collector), four relay outputs, and one switched 
+24V DC 1A output

Dimensions (W x D x H) 98 x 61 x 56 cm (39 x 24 x 22 in)*

*Maximum height. Z-arm height is adjustable to 
accommodate vessel heights between 1 and 150 mm 
(dependent on installed Z-arm)

Environmental Conditions Indoor use

Altitude: up to 2000 m

Temperature range: 5–40°C

Air pressure: 75–105 kPa

Humidity: Maximum relative humidity 80% for 
temperatures up to 31°C, decreasing linearly to 50% 
relative humidity at 40°C

Front Panel 8-character display, START soft key and emergency STOP 
soft key

Horizontal Motion Strength X: 5 kg (11 lbs)

Y: 7 kg (15 lbs)
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Injection Carryover <0.05%
Contact Gilson Customer Service to learn what methods and 
conditions were used to obtain this value

Locator Plate Capacity Up to five Code 200-series racks

or

One Code 505 or 505H rack plus one Code 200-series 
rack

Power Requirements Frequency: 50/60 HZ

Voltage: 100–120 V or 220–240V, mains voltage 
fluctuations not to exceed ±10% of the nominal voltage

Current rating: 2.0A for 100–120V or 1.0A for 220–240V

Probe Positioning Performance Accuracy: 

+/- 0.5 mm in X/Y dimensions

+/- 1 mm in Z dimension

Repeatability:

+/- 0.25 mm in X/Y/Z dimension

Probe Rinse Probe rinsing occurs through a dedicated rinse station 
for rinsing the inside and outside of the probes

Reproducibility Liquid Handling 0.57% CV with 500 μL of water

Injection

<2.0% CV with 500 μL syringe and 
partial loop filling method

<5.0% CV with 500 μL syringe and 
total loop filling method 

Contact Gilson Customer Service to learn what methods and 
conditions were used to obtain the values

Sampler Type X/Y/Z with stationary rack design

Software Gilson TRILUTION® LH Software

Technical Specification Definition
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Syringe Capacity/ Flow Rates
Syringe Size Maximum Flow Rate 

for Water

100 μL 3.3 mL/min

250 μL 8.4 mL/min

500 μL 16 mL/min

1000 μL 25 mL/min

2500 μL 25 mL/min

5000 μL 25 mL/min

Syringe Pump Internal integral high-precision eight-piston 
syringe pump

Vertical Punch Strength 0.6 kg/probe (1.4 lbs/probe)

Volumetric Accuracy Liquid Handling: 99.2% with 500 μL of water
Contact Gilson Customer Service to learn what methods and 
conditions were used to obtain this value

Weight 42 kg (93 lbs)

Technical Specification Definition
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Installation 2

This chapter takes you through the steps for setting up your Multiple Probe 215 Liquid Handler, which 
includes:

• Locator Plate Installation

• Armlock Removal

• Z-Arm Installation

• Probe Installation

• Syringe Installation

• Plumbing Connections

• Rack Setup

• Final Z-Arm Adjustment

• Rear Panel Connections

Z-axis

Z-arm cable
support

rod
control cabinet

front panel

syringe
pump

X-arm

rinse 
station

X-axis

locator 
plate

rack(s)Y-arm
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The locator plate serves two functions: 

• Positions the racks and accessories that fit onto the bed of the liquid handler.

• Contains liquid spills, such as those caused by overflowing vessels.

The locator plate and its four mounting screws are shipped in a separate box with 
the liquid handler’s accessories. 

To install the locator plate onto the instrument bed:

1 Make sure the locator plate’s rinse station base is at the rear of the 
instrument. (The locator plate will only install in this orientation.)

2 Align the four corner holes of the locator plate with the four holes on the 
instrument bed and lower the plate onto the bed.

3 Using a Phillips screwdriver, secure the locator plate using the four mounting 
screws.

pins to secure 
rinse station base(s)

holes to secure 
locator plate
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Armlock Removal

The armlock on the liquid handler secures the Y-arm during shipment. You must 
remove the armlock prior to installing the Z-arm and operating the instrument. If 
the armlock is not removed, the arm cannot move in the X direction. This results 
in an error state during operation.

If you need to move the liquid handler, always reinstall the 
armlock. This safeguards against mechanical damage.

To remove the armlock:

1 Remove the cardboard label in front of the armlock.

2 Using the 9/64" ball driver, loosen the tensioning screw that immobilizes the 
Y-arm.

3 Using the 9/64" ball driver, remove the two remaining screws that hold the 
armlock in place.

4 Remove the armlock and store it and ball driver for future use.

armlock

tensioning
screw securing 

screwY-arm
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Follow these steps to install the Z-arm:

1 Locate the Z-arm and the Z-height adjustment tool that was shipped with the 
Z-arm.

2 Locate the Z-arm mounting bracket on the Y-arm and then slide it forward for 
easier access to the mounting screw.

3 Using a Phillips screwdriver, loosen the mounting screw. (Turn 
counterclockwise to loosen.)

4 Partially pull out the bracket. Do not remove completely.

5 Place the Z-arm into the mounting bracket. Insert one side of the Z-arm into 
place at a time.

6 Tighten the mounting screw on the Z-arm mounting bracket, but leave it 
loose enough so that the Z-arm can slide up and down.

7 Place the Z-height adjustment tool on one of its ends near the center of the 
locator plate (if necessary, remove any racks or accessories before doing this).

8 Manually move the arm so the Z-arm is centered over the Z-height 
adjustment tool.

9 While holding Z-height adjustment tool flat against the locator plate, use the 
other hand to lower the Z-arm until it lightly rests on the adjustment tool.

Z-height
adjustment tool

Z-arm

mounting
screw
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10 Tighten the screw on the mounting bracket until the Z-arm is secure. 

11 While holding the adjustment tool in place, slide the Z-arm off the tool. 
Ensure that the bottom of the Z-arm lightly rubs against the adjustment tool 
as it moves.

12 Note the installed height of the Z-arm using the graduated scale located on 
one side of the arm and note it on this page. This clamp height is required 
when setting up parameters for the Z Height in the 215 Setup Utility as 
described on page 3-13.

13 Store the Z-height adjustment tool.

Z-arm

use top of mounting
bracket as scale reference

scale
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Z-Arm Connection

Plug the Z-arm control cable into the back topside of the control cabinet. The 
control cable should be tucked into the groove located in the top of the X-arm 
extrusion. The retaining clip that is already on the control cable should be 
snapped onto the top of the cable support rod. The control cable is correctly 
installed when the arm is extended to the extreme X and Y direction and the 
cable has enough slack. Refer to the diagram below.

Use the two Phillips screws to 
attach the mounting bracket 
and cable support rod to the 
rear of the X-arm extrusion.

mounting bracket with screws
 on the back of the liquid handler

retaining clip

cable 
support rod

control 
cabinet

plug-in 
cable

Z-arm 
control 
cable

cable 
support rod

tuck cable 
into extrusion

clip cable to 
support rod
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Probe Installation

There are different probes available for use with the liquid handler. Depending 
on your application, you have purchased the appropriate probes and probe 
holder/guide kit. When installing the probes refer to the diagram that shows 
where they are installed on the liquid handler.

To install the probes:

1 Insert each probe into the top of the probe holder.

2 Pull the probe through the holder until the tip of the probe is in the probe 
guide.

Note: When installing only four probes for use with an 849 Multiple Injection 
Module, install the probes in positions 1, 3, 5, and 7. 

Z-foot

probe 
guide

probe

probe 
holder



Installation 2

2-8 Gilson Multiple Probe 215 Liquid Handler

Sy
ri

n
g

e 
In

st
al

la
ti

o
n Syringe Installation

The pistons on the syringe pump are shipped in the down position. If the pistons 
are not in the down position, refer to the instructions for changing a syringe in 
Chapter 4, Maintenance. Those instructions detail how to lower the pistons.

The following procedure is important for correct syringe piston 
alignment. Improper alignment may cause premature piston seal 
failure.

When installing syringes, install the middle two syringes first and work outward. 
Only install syringes that will be used (i.e., four syringes for four probes). Or, 
disable the syringes that will not be used by removing the piston holding bolt.

To install each syringe refer to the diagram and instructions:

1 Remove a syringe from its package.

2 Lubricate the syringe’s piston with reservoir solvent in order to reduce piston 
seal friction during installation. Push the piston into the syringe to make 
installation easier.

3 Remove the fourth piston holding bolt (counting from the left) from the 
syringe slide.

4 Finger tighten the syringe holding fitting into the fourth position in the 
solenoid valve retainer. Then pull the syringe’s piston until it is aligned with 
the hole in the syringe slide.

5 Insert and finger tighten the piston holding bolt. Then using a screwdriver, 
tighten until snug.

6 To prevent pulling the syringe out of alignment when tightening the syringe 
holding fitting, use the bottom of the syringe retainer as a guide for the 
wrench. Then using a wrench, being careful not to hit the other syringes, 
tighten until snug.

7 Refer to the above steps to install the remaining syringes. Installing the 
syringes in the following order: 4, 5, 3, 6, 2, 7, 1, and 8 will maximize your work 
area when using the wrench.

Note: Remember the size of the syringes for later software configuration. (You 
can write the size in the margin here for reference.) See Syringe Options on 
page 3-10.

syringe 
holding 
screw

piston

piston 
holding 
bolt

  

syringe
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Plumbing Connections

Inlet Tubing Installation

You received eight lengths of inlet tubing (part number 3645357) with your 
liquid handler.

1 For each piece of inlet tubing, install its 1/4"-28 fitting into an “R” (reservoir) 
labeled hole located on top of the solenoid valve retainer.

2 Place the filtered end of the tubing into the bottle containing your diluent or 
probe rinse solution.

Note: If you need to lengthen the inlet tubing, order additional tubing 
(part number 49948392) and couplings (part number F1410153).

to reservoir

to probe

solenoid valve retainer
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After installing the inlet tubing, install the transfer tubing.

1 Install the tubing support rod 
in its brackets on the side of 
the control cabinet. Insert the 
front end of the rod into the 
hole before placing the back 
end of the rod in its cradle.

2 Starting with transfer tubing 1 
and proceeding from left to 
right, connect one end of each 
tubing into a “P” (probe) 
labeled hole in the solenoid 
valve retainer. Finger tighten 
and then turn the fitting 1/4 
turn with a wrench.

Note: If you’re installing 
5.5 mL tubing, connect the 
wider-head fitting to the 
solenoid valve retainer. The 
narrower-head (or headless) 
fitting attaches to the probe 
holder.

3 Lift the back end of the tubing 
support rod from its cradle. 
Then wrap the transfer tubing around the rod; wrap the tubing three or four 
times around the rod. Replace the tubing support rod.

4 Connect the other end of each transfer tubing to the corresponding position 
in the probe holder. Firmly tighten this fitting.

transfer 
tubing

1/4"- 28 
fitting

probe 
holder

probe
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5 Locate the spiral wrap and cut two 4" lengths: 

a) Install one piece of spiral wrap around the transfer tubing between the 
solenoid valve retainer and support rod. 

b) Lower the Z-arm and then use the other piece of spiral wrap to join the 
transfer tubing to the control cable. 

6 Gather any excess tubing into a coil to minimize the length of tubing and 
secure the coil using a twist tie. Position the excess tubing in a convenient 
location behind the liquid handler.

7 Move the Z-arm to the farthest location in the X and Y directions to ensure 
that the Z-arm can move freely. Reposition the spiral wrap if necessary, or cut 
and install additional lengths if necessary.

Install the 
spiral wrap here

Use the spiral wrap
to join the transfer
tubing to the control cable

Wrap the tubing 
around the 
support bar
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Clean the probes using the rinse station. To eliminate liquid cross contamination, 
a rinsing procedure should pump an excess volume of reservoir solvent or probe 
washing solution through the probes and out into the rinse station. The small 
diameter of the rinse station ports allow the outsides of the probes to be washed 
along with the insides.

The rinse station’s design accommodates three kinds of rinses:

• Inside Rinse (center trough) - Used for rinsing the inside of the probes and as 
a drain. Liquid is purged out of the probes to the drain.

• Outside Deep/Flow-Through Rinse (back row of rinse wells) - This type of 
rinse allows for a deeper insertion of the probe into the rinse wells resulting 
in a greater area of the outside of the probes to be rinsed. The flow-through 
rinse is used in applications where a rigorous wash of the probes’ exterior is 
required. A second source of liquid is pumped to the rinse station to perform 
this type of rinse.

• Outside Shallow Rinse (front row of rinse wells) - Used for rinses after the 
probes have only been immersed in a few millimeters of sample.

It may be necessary to vary the types and volumes of probe wash solutions to 
most efficiently eliminate carryover of particular compounds. Generally, the 
smaller the volume of probe wash solution used, the faster your automated 
liquid handling protocol.

ports for outside deep

inside rinse

ports for outside shallow rinse

 and flow-through rinse
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Install the Rinse Station

The base of one rinse station is shipped already secured to the locator plate and 
is located at the left-rear of the locator plate. The locator plate can hold an 
optional second rinse station or you can move the rinse station base to an 
alternate location.

Before installing the rinse station, make sure the locator plate has been properly 
installed with the installed rinse station base located at the rear of the instrument 
bed.

pins to secure rinse station base(s)

holes to secure locator plate
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1 Align the triangle on the bottom of the rinse station with the base.

2 With the rinse station’s fittings facing you, insert the rinse station into the 
base.

3 Press down and turn the rinse station clockwise. The rinse station is secure 
when you feel the rinse station snap into place. When installed correctly, the 
fittings point toward the control cabinet.

4 Connect waste tubing to the barbed fitting installed on the rinse station.

If you will be doing flow-through rinses, remove the plug installed on the 
rinse station and replace it with a barbed fitting. Connect tubing between 
the barbed fitting and the external liquid source.

top hole

Use the top hole for storage of the
unused barbed fitting or plug.

barbed fitting

Connect Tygon tubing between
the fitting and waste bottle.

plug

For flow-through rinse, replace plug
with a barbed fitting and connect

tubing between the fitting and the
external liquid source.
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The Multiple Probe 215 Liquid Handler is equipped to locate Code 200- and 
500-series racks. For a list of racks available for the liquid handler see Appendix B, 
Racks.

Place the Code 200- or 500-series racks directly onto the locator plate:

1 Orient the rack so that the code number (for example, 200) is facing forward.

2 Fit the rack on the locator plate so that the slots and holes on the underside 
of the rack align with the pins on the locator plate.

Note: Although the Multiple Probe 215 Liquid Handler is equipped to locate all 
Code 200- and Code 500-series racks, not all vessel patterns are compatible with 
a four or eight probe configuration. For a list of racks available for use with 
multiple probes on the liquid handler see Appendix B, Racks.
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Follow these steps to verify that the Z-arm has been clamped high enough for the 
configuration:

1 Manually move the arm within the working area of the locator plate.

2 Verify that the arm passes approximately 5 mm above the top of the tallest 
vessel in a rack and above the rinse station.

3 If the arm passes freely and is not obstructed, continue the installation by 
making rear panel connections as described in the next section.

If the arm does not clear vessels or the rinse station:

a) Loosen the mounting screw so that the Z-arm can move up and down.

b) Raise the Z- arm up to clear the vessels and rinse station by a minimum of 
5 mm.

c) Tighten the screw on the mounting bracket until the Z-arm is secure. 

4 Note the installed height of the Z-arm using the graduated scale located on 
one side of the arm and note it on this page. Be sure to enter this new clamp 
height when setting up parameters for the Z Height in the 215 Setup Utility 
as described on page 3-13.

Z-arm

use top of mounting
bracket as scale reference

scale
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Rear Panel Connections

Rear Panel Diagram

1 Input/Output ports

2 Gilson Serial Input/Output 
Channel (GSIOC) port

3 Keypad port (not used)

4 RS-232 port

5 Fuse drawer

6 Power switch

7 Power receptacle

8 SW1 (unit ID) selector

9 SW2 (control) selector
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You can use the input and output contacts found on the rear panel of the 
liquid handler to control peripheral devices. Refer to the Rear Panel Diagram on 
page 2-17 for the location of the input/output ports.

Inputs

The input terminal block of the liquid handler has four contacts. All of the inputs 

are paired, and each pair includes a GROUND reference ( ).

The contact input pairs are labeled A–D.

A contact is connected if it has a short across the input or is held low by a TTL 
output or other device.

Never connect voltages higher than 5V DC to an input. When using TTL signals, 
be sure to match GROUND connections.

Outputs

The output terminal block has five contacts. All of the outputs are paired.

Pins 1 and 2 supply ground and a +24V DC output. Do not use this output unless 
the receiving device can accept 24V power.

Outputs labeled 1–4 are paired, isolated-relay contact closures.

Make Connections

The following are needed to make connections:

• terminal block connectors

• 2-conductor cable (22–30 gauge for each wire)

You can purchase a 6-foot piece of suitable cable (part number 709910206) 
or a package of 5 cables with identification markers 
(part number 36078155) from Gilson.

• wire insulation stripper

• small-blade screwdriver
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To make connections using the 2-conductor cable:

1 Cut the cable into pieces of appropriate length.

2 Strip about 0.25 cm of insulation from each end of 
the cable.

3 Locate the appropriate green terminal block 
connector in the accessory package. The connector 
for inputs has eight terminals while the one for 
outputs has ten.

4 Insert each wire into the appropriate terminal on the 
terminal block connector. Push the wire all the way in and then tighten its 
corresponding pin screw.

Note: When making connections, be sure to maintain the correct orientation 
of the connector relative to the port. This is especially important if making 
connections to the +24V DC output.

5 Connect the terminal block connector to the liquid handler. The wires will be 
facing left and the pin screws will be facing you as you look at the rear of the 
instrument. Push the connector in as far as it will go. It is designed to fit 
snugly into its receptacle.

6 Connect the opposite ends of the wires to the other device(s). Be sure to 
match GROUND connections.

7 Label each cable to identify the purpose of the connection.

RS-232 Port

The RS-232 port is used to transfer information between the liquid handler and a 
computer. For the location of the RS-232 port, refer to the Rear Panel Diagram 
on page 2-17.

To connect your computer to the liquid handler, you need an RS-232 cable.

Connect the RS-232 Cable

Attach the 25-pin, male end of the RS-232 cable to the RS-232 port located on 
rear panel of the liquid handler. Tighten the retaining screws.

Attach the female end of the RS-232 cable to the computer’s RS-232 serial 
communications port. Tighten the retaining screws.

terminal block 
connector

2-conductor
cable

to peripheral
equipment
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Use the GSIOC cable to link other instruments to the liquid handler and control 
all from one computer. A GSIOC cable has two 9-pin female connectors and one 
9-pin male connector.

The following diagram shows the cabling connections between a computer, 
liquid handler, and GSIOC module.

Gilson
module

Gilson
module

GSIOC
cables

RS-232 cable

to computer



Gilson Multiple Probe 215 Liquid Handler 2-21

Installation 2
R

ear Pan
el C

o
n

n
ectio

n
s

Connect the female connector, located individually at one end of the cable, into 
the GSIOC port of the liquid handler. Tighten the retaining screws. (Refer to 
diagram below.)

Connect the other female connector, located on the same end as the male 
connector, to the Gilson module. Tighten the retaining screws.

If you are connecting more than one Gilson module, use the male connector to 
attach an additional GSIOC cable. Use the female connectors to connect each 
Gilson module.

Cables should be arranged in a linear fashion. Any “Y-branching” from the main 
GSIOC cable may increase noise.

SW1 (Unit ID) Selector

Use the SW1 selector to choose a different unit ID. Refer to the Rear Panel 
Diagram on page 2-17 for the location of the selector.

The unit ID identifies the liquid handler to Gilson software packages that can 
issue GSIOC commands to the liquid handler.

The unit ID is set to 22. There is no need to change this number unless it is the 
same as that assigned to another Gilson instrument that’s also connected along 
the GSIOC.

To change the unit ID:

1 Gently insert a small flat blade screwdriver into the SW1 selector on the rear 
panel and turn it.

2 Align the white dot with one of the indicated numbers. The unit ID is 20 plus 
the selected number.

9-pin female 
connector; 
connect to 
liquid handler

9-pin female connector;
connect to interface module

or GSIOC cable for linking
additional GSIOC modules

9-pin male connector; 
connect to GSIOC cable 

for linking additional 
GSIOC modules
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Use the SW2 selector to set the liquid handler for GSIOC control. For the location 
of the selector, refer to the diagram on page 2-17.

The SW2 selector is set to 8, indicating that the liquid handler is set for RS-232 
control.

Change the setting to 0 (zero) if the liquid handler is connected via the GSIOC to 
a Gilson system and is being controlled by Gilson control software.

To change the control setting:

1 Gently insert a small flat blade screwdriver into the SW2 selector on the rear 
panel and turn it.

2 Align the white dot with one of the indicated numbers.

Fuse Installation

You received the liquid handler without any fuses installed. 

To install the fuses:

1 Locate the accessory package containing the fuse drawer appropriate for 
your line voltage.

2 Locate the accessory package containing the 2.5A "T" Slo-Blo (5 x 20 mm size) 
fuses.

3 Install the fuse(s) into the fuse drawer. The fuse drawer for 100/120V accepts 
one fuse. The fuse drawer for 220/240V accepts two fuses.

4 Insert the fuse drawer into its receptacle in the liquid handler. For the 
location of the receptacle, refer to the Rear Panel Diagram on page 2-17.

Fuse Installation for
100/200 voltage

Fuse Installation for
220/240 voltage
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Power Cord Connection

Locate the appropriate power cord for your line voltage. 

Use the power cord to connect the liquid handler to a power source.
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TRILUTION® LH Software provides programmed control of the Multiple Probe 215 Liquid Handler. 

This chapter provides the following information:

• A description of the Front Panel of the liquid handler

• How to Start Up the liquid handler

• How to use the 215 Setup Utility

• Instructions for using the 215 Priming Utility

• How to Test the Liquid Handler’s Contacts
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The front panel of the liquid handler contains a Start button, Stop button, display, 
and power indicator light.

Start Button

The Start button can be used to home the XYZ-arm when the liquid handler is 
first powered up or when the motors for the XYZ-arm have been relaxed. When 
pressed, the yellow display light is turned on.

Stop Button

The Stop button is a large touch-sensitive pad that can be used to stop the 
liquid handler and also relax the motors for the XYZ-arm so that you can easily lift 
the probes and move the arm. When pressed, the yellow display light is turned 
off.

In a situation where an emergency stop is required, pressing the Stop button 
immediately stops the liquid handler. The stop button is designed to be sensitive 
enough that if you just brush it with your hand, it activates.

Start display

power
indicator
light

STOP
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Display

The 8-character display shows the current status of the liquid handler and any 
error codes as they are encountered. Your program can also contain instructions 
for showing 8-character messages on the display when the program is run.

Refer to Chapter 5, Troubleshooting for a list of current error codes and required 
actions.

Power Indicator Light

This indicator becomes lit when you turn on power to the liquid handler using 
the power switch located on the rear panel. Refer to the Rear Panel Diagram on 
page 2-17, if necessary.
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To start the liquid handler:

1 Make sure that the armlock has been removed.

2 Make sure that the liquid handler is connected to a power source.

3 Turn on the liquid handler using the power switch located on the rear panel. 
Refer to the Rear Panel Diagram on page 2-17, if necessary. The power 
indicator light on the front panel illuminates.

When power is turned on, the liquid handler beeps and displays the current 
version of its installed firmware. This message appears for about one second 
before the display returns to a blank state.

In order to determine what PROM version is installed in your liquid handler, 
you may need to turn the unit off then on again and watch the display for the 
version number to appear.

4 After the liquid handler powers up, press the Start button. This initiates the 
homing sequence that allows the liquid handler to determine its mechanical 
reference positions. The sequence takes approximately one minute to 
complete.

While the homing sequence progresses, the display shows Homing. When 
the sequence completes, the display is blank.
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215 Utility Programs

The 215 Utility Programs CD-ROM, provided with your liquid handler, supplies 
the following utility programs:

215 Setup Utility - Specifies configuration parameters for the liquid handler.

215 Priming Utility - Primes the transfer tubing.

215 Contact Test Utility - Enables you to test contact connections.

215 Injection Z-Height Utility - This utility is not applicable for the 
Multiple Probe 215 Liquid Handler.
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Follow the on-screen instructions.

When prompted, restart the computer.

1 2

3 4

5 6
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Start 215 Utility Programs

Windows® 2000/XP

For communication to occur, the Multiple Probe 215 Liquid Handler must be 
connected via an RS-232 or GSIOC to RS-232 connection to the computer. For 
information about making these connections, see Chapter 2, Installation.

To start a utility program, click START | ALL PROGRAMS | 
GILSON APPLICATIONS | 215 Liquid Handler and then select a utility program 
from the list.

Help

On-line help is included for the 215 Utility Programs. The on-line help describes 
commands and dialogs displayed in the software and the procedures needed to 
perform tasks.

Click  to display help about the dialog box.
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The liquid handler comes with its configuration set by Gilson. Configuration 
information is stored in the non-volatile memory of the liquid handler. Prior to 
using the liquid handler for the first time, it is important to review and adjust the 
default configuration to make sure it is correct for your application.

The following pages describe how to configure a liquid handler using the 
215 Setup Utility. Refer to the online help for assistance.

The 215 Setup Utility allows you to review and if necessary change the 
configuration options set for the liquid handler. 

When you execute the utility program from your computer, the following screen 
with menu tabs appears:

Section Described on

About... page 3-17

Adjust XY page 3-12

Bearing Life page 3-15

Emergency Contact page 3-16

Home Phase page 3-14

Liquid Detector page 3-11

Pump Type page 3-9

Rinse Site page 3-11

Safety Contact page 3-15

Sound and Display page 3-16

Syringe Options page 3-10

Z Heights page 3-13
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Pump Type

Use the Pump Type tab to 
set the type of 
syringe pump installed in 
the instrument. If the 
pump type actually 
installed does not match 
the setting indicated here, 
an error will occur during 
operation.

Pump type selections are:

• Blank Front (no syringe pump is installed)

• 1 Syringe (not used for the Multiple Probe 215 Liquid Handler)

• 8 Syringe

• Other (for future use)

To store the pump type to memory, click OK.

To display the pump type currently set in the memory, click Cancel.
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Under the Syringe Options 
tab, you indicate the size of 
the installed syringes or 
click the Lower Syringe 
button so you can install 
new syringes.

Use the option buttons to 
select the correct syringe 
size in microliters. If you do not know the size of the syringes installed, check the 
containers in which the syringes were shipped for size information. An incorrect 
setting can cause improper volumes to be aspirated or dispensed during 
liquid handler operation or can cause an error to occur.

To store the syringe capacity to memory, click OK.

To display the syringe capacity currently set in the memory, click Cancel.

Clicking Lower Syringe facilitates replacement with a new syringe by causing 
the syringe pistons to move to the bottom of the stroke.

Clicking Raise Syringe facilitates replacement with a new syringe by causing the 
syringe pistons to move to the top of the stroke. 
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Rinse Site

The instrument stores the 
location of a rinse site in 
memory. This allows the 
instrument to move to this 
location before homing 
the syringe and prevents 
the spilling of waste liquid 
or rinse diluent.

Review, and if necessary, change the rinse site coordinates. Refer to the following 
table to select the correct X, Y, and Z coordinates (in millimeters) depending on 
the location of the rinse station (default is left-side) and the kind of probe rinse to 
be performed. The coordinates identify the rinse site for the left-most probe 
installed on the Multiple Probe 215 Liquid Handler.

To store the rinse site coordinates to memory, click OK.

To display the rinse site coordinates currently set in the memory, click Cancel.

Liquid Detector

The Liquid Detector tab is 
not applicable for the 
Multiple Probe 215 
Liquid Handler.

Left-side
rinse station

Right-side
rinse station

X Y Z X Y Z

Shallow-pocket rinse 82.9 16.5 100.0 441.6 16.5 100.0

Deep-pocket and 
Flow-through rinse

82.9 3.8 47.5 441.6 3.8 47.5
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The Adjust XY tab allows 
you to test whether the 
instrument is properly 
adjusted and to make 
minor adjustments to the 
X- and Y-axis offsets if 
needed. You may need to 
use the options under this 
tab if the probe is not accessing the injection port of the injection module 
installed or the vessels in the installed racks.

The X offset and Y offset text boxes display the current offsets stored in the 
instrument’s memory.

To determine if the probe needs to be adjusted in the X or Y direction:

Select the model of the injection module that is on your Multiple Probe 215 
Liquid Handler (likely an 849 Injection Module) or select other for a user-defined 
test point. The default X,Y coordinates are shown next to the model number.

Injection Module Coordinates

849:
X-coordinate: 336.1 mm
Y-coordinate: 3.8 mm

other:
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Z Heights

Use the Z Heights tab to 
identify the size of the 
installed Z-arm and the 
height at which the Z arm is 
clamped.

Use the option buttons to 
select the correct tower 
height in millimeters. 
Setting the tower height of the Z-arm determines the amount of possible travel 
in the Z-axis. If you do not know the height of the tower installed, check the Z-arm 
for a label or the container in which the tower was shipped for height 
information. An incorrect setting could cause the probes to be damaged during 
liquid handler operation.

The Z-arm can be clamped at an adjustable height over the locator plate. You can 
set this height so that the liquid handler is able to properly find heights that you 
specify. Type the clamp height in millimeters. A clamp height of 0 mm means the 
bottom of the Z-arm is flat on the locator plate.

To store the selected Z-height settings to memory, click OK.

To display the Z-height settings currently set in memory, click Cancel.
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Use the Home Phase tab to 
display the current X and Y 
phase of the instrument.

Clicking Start causes the 
liquid handler to perform 
the phase procedure. This 
procedure consists of the 
liquid handler homing 
itself 10 times.

The liquid handler finds out where home is located by "feeling" for the back and 
left walls of the unit. The liquid handler expects to find these walls in the same 
place each time. If it does not, you will get an error. If this error was caused by an 
obstruction, just clear the obstruction and try again. If the problem does not clear 
or if a change is made to the mechanics, you will probably need to repeat this 
option to find the true home location.

Once the process completes, the spreadsheet displays the values generated from 
each phase procedure.

To store the new phases to memory, click OK.

To display the home phase information currently set in memory, click Cancel.
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Safety Contact

The instrument has 
provisions for connecting 
safety devices that your 
application may require, as 
long as they present a 
contact closure or TTL type 
interface. The 
Safety Contact tab allows 
you to specify which input contact is connected to the safety device and what is 
the active state of that device. The function of the safety contact is equivalent to 
pressing the Stop button on the instrument’s front panel.

To use this option, choose one or more of the check boxes and then click OK to 
store the information to memory.

Or, to display the safety contacts currently set in memory, click Cancel.

Bearing Life

The Bearing Life tab 
displays the XYZ travel in 
kilometers, the number of 
full strokes performed by 
the syringe pump (if 
applicable). Spring Cycles 
is not applicable to the 
Multiple Probe 
215 Liquid Handler.



Operation 3

3-16 Gilson Multiple Probe 215 Liquid Handler

21
5

Se
tu

p
 U

ti
lit

y Sound and 
Display

Use the options in the 
Sound / Display tab to 
adjust the brightness of 
the display, sound level, 
and tone.

Clicking Beep tests the 
sound level and tone that are currently selected.

For the display brightness, you can select a range of 0 through 7 where 0 is the 
dimmest and 7 is the brightest. Default setting is 5.

To store the selected options to memory, click OK.

Or, to display the options currently set in memory, click Cancel.

Emergency 
Contact

The emergency contact 
option provides for 
sending a signal to a 
peripheral device 
whenever the 215’s Stop 
button is pressed or safety 
input is activated.

To store changes to the emergency contacts, click OK.

To display the emergency contact(s) currently set in memory, click Cancel.
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About...

The About tab allows you 
to indicate the unit ID of 
the instrument being 
configured so the 
215 Setup Utility can 
communicate with that 
instrument.

This tab also lists software 
version and copyright information for the 215 Setup Utility.

The Set Type button allows you to manually set the type of 215 you are using. 
Unless the Non-Volatile RAM has been cleared, this information will appear 
automatically.

Next to the “Model 215 Unit ID” text box you will see the following:

To change this setting, click the drop down menu next to the Set Type button and 
select the appropriate 215 type. Click Set Type to accept the change.

Multiple Probe 215 = 215MULvX.XX
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The 215 Priming Utility primes your syringes and transfer tubing lines with liquid 
from your syringe pump’s reservoir. Gilson recommends using the 215 Priming 
Utility before using the liquid handler for the first time or if the liquid handler has 
not been used for some time. Using the software will eliminate air in the transfer 
tubing.

Start the Priming Cycle

In the software, indicate a priming speed (in milliliters per minute). Then click on 
the Prime option button. Before priming begins, the liquid handler homes the 
probes and then moves them to the rinse station. When the probes are at the 
rinse station, priming begins.

Pause the Priming Cycle

You can pause the priming cycle at any time by clicking on the Pause option 
button. If a pause is activated while the syringes are in a downward motion, the 
software stops the syringes at the bottom of the stroke. If a pause is activated 
while the syringe pump is in an upward motion, the software stops the syringes 
at the top of the stroke. When you pause the priming cycle, ‘Pause’ appears on 
the liquid handler’s display. To continue the priming cycle, click on the Prime 
option button.

Stop the Priming Cycle

To terminate priming, click the Stop option button. This causes the syringes to 
home.

Exit the Software

Click Done to close the software.
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Test the Liquid Handler’s Contacts

The 215 Contact Test Utility  allows you to activate output contacts that 
determine if the correct contact connections are made to peripheral devices 
controlled by the liquid handler. It also identifies the state of input contacts.

Before using this program, you need to connect the peripheral device’s inputs to 
the appropriate output pair on the liquid handler. If necessary, refer to 
Input/Output Ports on page 2-18 for information on making contact 
connections.

While the 215 Contact Test Utility  is running, the program continuously displays 
the state of outputs and inputs. When an output contact is active, a check 
displays next to the output contact and when inactive, it remains blank. For 
example, to activate output contact 24V, click the toggle box next to 24V. A check 
displays indicating 24V is active. Click the toggle for an active output contact and 
it becomes inactive.

To exit the software, click Done.
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To obtain optimum performance and maximum life from the Multiple Probe 215 Liquid Handler, it is 
important to keep the instrument well-maintained.

The Multiple Probe 215 Liquid Handler is intended to be used in a laboratory environment by trained 
technical personnel.

This chapter contains the following information to help you to maintain your liquid handler:

• Helpful Hints

• Cleaning

• Replace Parts

• Check Position Alignment

• Transport the Liquid Handler
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In order to keep your liquid handler at peak performance, Gilson recommends 
that you do the following:

• Change or clean the piston seals and tubing regularly to maintain maximum 
syringe pump performance.

• Do not cycle the syringe pump without fluid. Doing this causes excessive 
piston seal wear.

• Flush the syringe pump, probes, and rinse stations daily with distilled or 
deionized water. On a weekly basis, flush with a 10% solution of bleach or 
weak detergent.

• If bubbles remain in the syringes after priming, clean the syringes with 
alcohol.

• Check periodically to ensure that all fittings are tight.

• Check that each syringe is tightly connected to the solenoid valve retainer 
and multiple probe syringe slide. Refer to diagram on next page.

• Wipe up all spills immediately.

• Cold fluids may cause leakage; warm fluids to room temperature before 
running them through the system.
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Cleaning

Clean the Liquid Handler

The liquid handler should be cleaned occasionally using a dry, clean cloth. Or, if 
necessary, use a cloth dipped in soapy water. If liquid is accidentally spilled on the 
liquid handler, wipe the instrument using a dry, clean cloth.

Clean a Syringe

Clean a syringe when some or all of the following occurs:

• Corrosive or hazardous liquids have been pumped

• Possible back flow of liquids into the waste tubing

• Leakage

• Aspiration of samples or reagents into a syringe

To clean a syringe, follow the procedures on the next page and use the diagram 
below as a reference.

to reservoir

to probe

solenoid valve retainer

syringe holding fitting

syringe

piston

piston holding bolt

syringe slide
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Before cleaning a syringe, disconnect it from the solenoid valve retainer and 
multiple probe syringe slide as described below. The following procedures use 
the 215 Setup Utility.

1 Start the 215 Setup Utility, described on page 3-8.

2 Select the Syringe Options tab. The option button for the installed syringe 
size is selected. Click Lower Syringe. This causes the piston to descend as the 
syringe pump aspirates from the reservoir. The syringe pump will stop at the 
bottom of the stroke, switching the valve to the outlet position.

3 After the syringe has been lowered, remove the syringe’s piston holding bolt 
from the syringe slide.

4 Unscrew the syringe from the solenoid valve retainer. You may need to use a 
wrench or needle-nosed pliers to accomplish this step.

Clean Syringe

After the syringe has been removed, it can be cleaned:

To prevent injury, observe good laboratory practices when 
handling solvents. Know the physical and chemical properties. 
Refer to the Material Safety Data Sheets for the solvents used.

1 Place the syringe in a beaker containing methanol. Then aspirate and 
dispense several volumes of methanol through the syringe.

2 Place the syringe in a beaker containing distilled or deionized water. Then 
aspirate and dispense several volumes of water through the syringe.

3 Hold the syringe housing in one hand. Clean the syringe using a 
non-abrasive cloth dampened with alcohol. Remove the piston and clean the 
piston with a non-abrasive cloth dampened with alcohol.

4 Dry the syringe and piston using a clean, lint-free cloth.
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Reinstall Syringe

When the syringe is clean, reinstall it:

1 Lubricate the piston with reservoir solvent in order to reduce friction on the 
piston seals during reinstallation.

2 Finger tighten the syringe holding fitting into the solenoid valve retainer. 
Then using a wrench, tighten the screw 1/8 turn. 

3 Pull the syringe’s piston until it is aligned with the hole in the syringe slide.

4 Insert and finger tighten the piston holding bolt. Then using a flathead 
screwdriver, tighten the screw 1/4 turn.

Clean the Fluid Path

Depending upon your use of the liquid handler, it may be necessary to flush the 
entire fluid path. When flushing the fluid path it is recommended to use a volume 
that is equal to ten times the syringe volume plus the transfer tubing volume 
times the number of syringes.

flush volume = 
10 * (syringe volume+ transfer tubing volume) * number of syringes

It’s important to clean the fluid path if you won’t be using the liquid handler for 
a while or if you’re using a solution with a high salt concentration for a 
probe wash or as a diluent. 

To prevent injury, observe good laboratory practices when 
handling solvents. Know the physical and chemical properties. 
Refer to the Material Safety Data Sheets for the solvents used.

Refer to the instructions below:

1 Prime the fluid path with distilled or deionized water.

2 Flush the fluid path with 30% ethanol. The fluid path has now been cleaned 
appropriately for weekend storage (or longer).

3 Prime and flush the fluid path with distilled or deionized water before 
running applications.
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Depending on the samples or reagents that come into contact with the 
fluid path, you may need to vary your cleaning methods accordingly. Use the 
following cleaning protocols as references and make any changes to them as 
required for the samples and reagents being pumped for your application.

Proteins and peptides - Follow this procedure if the fluid path is in contact with 
proteins and peptides:

To prevent injury, observe good laboratory practices when 
handling solvents. Know the physical and chemical properties. 
Refer to the Material Safety Data Sheets for the solvents used.

1 Prime the fluid path with distilled or deionized water.

2 Flush the fluid path using a weak detergent solution.

3 Pause the priming sequence.

4 After 30 minutes, resume flushing and priming the fluid path using distilled 
or deionized water to pump the remaining detergent from the tubing into a 
waste container. 

5 When you’re satisfied that the entire fluid path has been flushed with water, 
end the priming sequence. 

Acidic compounds, basic compounds, or salt solutions - Follow this procedure 
if the fluid path is in contact with acidic compounds, basic compounds, or salt 
solutions:

To prevent injury, observe good laboratory practices when 
handling solvents. Know the physical and chemical properties. 
Refer to the Material Safety Data Sheets for the solvents used.

1 Prime the fluid path with distilled or deionized water.

2 Flush the fluid path using a 0.1N NaOH solution. 

3 Pause the priming sequence.

4 After 10 minutes, resume priming the fluid path using distilled or deionized 
water. Prime until the fluid path has been flushed with water.

5 Pause the priming sequence.

6 Prime the fluid path using a 0.1N HCl solution. 

7 Pause the priming sequence.

8 After 10 minutes, resume priming the fluid path using distilled or deionized 
water. 
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Biological fluids - Follow this procedure if the fluid path is in contact with 
biological fluids such as blood products:

To prevent injury, observe good laboratory practices when 
handling solvents. Know the physical and chemical properties. 
Refer to the Material Safety Data Sheets for the solvents used.

1 Prime the fluid path with distilled or deionized water.

2 Make a solution of 10% bleach by adding one part of commercial bleach to 
nine parts of water.

3 Flush the fluid path using the bleach solution.

4 Pause the priming sequence.

5 After 30 minutes, resume priming the fluid path using distilled or deionized 
water to pump the remaining bleach solution from the tubing into a waste 
container. 
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Tubing

It is important to keep all tubing clean and free of crimps. Tubing that has 
become dirty, blocked or crimped can result in poor accuracy and precision, loss 
of air gap or the syringe stalling.

Replace both the transfer tubing and inlet tubing as needed. See Appendix A, 
Replacement Parts and Accessories for part numbers for replacement tubing. 
For tubing installation procedures, see Chapter 2, Installation.

Piston Seal

To change a piston seal, refer to the instructions supplied with the replacement 
seal. For part numbers for replacement seals, contact your Gilson-authorized 
representative.
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Syringe

If necessary, refer to the diagram Clean a Syringe on page 4-3 while performing 
the procedures below. The following procedures use the 215 Setup Utility.

Remove Syringe

Before cleaning a syringe, disconnect it from the solenoid valve retainer and 
multiple probe syringe slide as described below. The following procedures use 
the 215 Setup Utility.

1 Start the 215 Setup Utility, described on page 3-8.

2 Select the Syringe Options tab. The option button for the installed syringe 
size is selected. Click Lower Syringe. This causes the piston to descend as the 
syringe pump aspirates from the reservoir. The syringe pump will stop at the 
bottom of the stroke, switching the valve to the outlet position.

3 After the syringe has been lowered, remove the syringe’s piston holding bolt 
from the syringe slide.

4 Unscrew the syringe from the solenoid valve retainer. You may need to use a 
wrench or needle-nosed pliers to accomplish this step.

Install New Syringe

1 Lubricate the piston with reservoir solvent in order to reduce friction on the 
piston seals during reinstallation.

2 Finger tighten the syringe holding fitting into the solenoid valve retainer. 
Then using a wrench, tighten the screw 1/8 turn. 

3 Pull the syringe’s piston until it is aligned with the hole in the syringe slide.

4 Insert and finger tighten the piston holding bolt. Then using a flathead 
screwdriver, tighten the screw 1/4 turn.

Note: If you are installing new syringes and they are a different size than the 
ones being replaced, run the 215 Setup Utility (Syringe Options tab) and 
change the syringe size.
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To replace a nonworking solenoid valve, follow these steps:

1 Remove the valve’s syringe, as described under Remove Syringe on 
page 4-4.

2 From the top of the solenoid valve retainer, detach the reservoir tubing for 
the nonworking valve.

3 From the top of the solenoid valve retainer, detach the transfer tubing for the 
nonworking valve.

4 Using a 9/64" hex wrench, loosen the screws that secure the cover of the 
solenoid valve retainer.

5 Looking down into the solenoid valve retainer, locate the nonworking valve.

6 Locate the cable and connector for the nonworking valve. Then disconnect 
the connector from the electronics board. Note the orientation and location 
of the connector so it can later be reinstalled to the appropriate location.

7 Remove the connector located above or below the connector that you 
disconnected in step 6. Once again, note the orientation and location of the 
connector so it can later be reinstalled to the appropriate location.

8 Remove the nonworking valve by grasping the valve and gently pulling it 
about 3/8" towards you. Lift the valve upward when its collar is beyond the 
collars of the adjacent valves.

9 Install the replacement valve.

10 Attach the replacement valve’s connector to the appropriate location on the 
electronics board.

11 Reattach the connector for the adjacent valve to the appropriate location on 
the electronics board.

12 Reinstall the syringe as described in mounting new syringe under Reinstall 
Syringe on page 4-5.
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Probes

Refer to the diagram and 
appropriate instructions below.

Install the Same Type of 
Probe

1 Remove the transfer tubing’s 
1/4"-28 fitting connected to the 
top of the probe holder.

2 Grasp the current probe and 
push it up through the top of 
the probe holder.

3 Install the new probe by 
pushing it through the top of 
the probe holder. Make sure the 
tip of the probe sits inside the 
probe guide.

4 Replace and tighten the 
1/4"-28 fitting.

Install Different Type of Probes

To install replacement probes of a different type than are currently installed, you 
must obtain a probe holder/guide kit and the replacement probes.

1 Remove the transfer tubing fittings connected to the top of the probe holder.

2 Remove each probe by pushing it up through the top of the probe holder.

3 Remove the screws that attach the current probe holder to the Z-arm. Install 
the new probe holder.

4 Remove the screws that attach the current probe guide to the Z-arm foot. 
Install the new probe guide.

5 Install each new probe by pushing it through the top of the probe holder. 
Make sure the tip of each probe sits inside the probe guide.

6 Reattach the transfer tubing to the probe holder.

Z-foot

probe guide

probe

probe holder
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A blown fuse may indicate the existence of another problem in the instrument. If 
the replacement fuses blow, do not try additional fuses. Contact your 
Gilson-authorized representative. See Before Calling Us on page 5-9.

To change a fuse, follow these steps.

1 Disconnect the power cord from the power outlet and from the rear panel 
receptacle.

2 Locate the fuse drawer on the rear panel. See Rear Panel Diagram on 
page 2-17 if necessary.

3 Insert a small screwdriver into the notch under the fuse drawer.

4 Twist the screwdriver to open and remove the fuse drawer. The fuse drawer 
contains one 2.5A "T" Slo-Blo fuse (5 x 20 mm size) for a 100/120 voltage 
selection. It contains two 2.5A fuses for a 220/240 voltage selection.

5 Remove the old fuse(s) and insert the new fuse(s).

6 Insert the fuse drawer into its receptacle in the liquid handler.

fuse 
drawer

Fuse drawer for 100–120 voltage selection Fuse drawer for 220–240 voltage selection
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Check Position Alignment

The 215 Setup Utility, described in Chapter 3, Operation, allows you to test 
whether the liquid handler is properly aligned and to make minor adjustments to 
the X-axis and Y-axis offsets if needed. For example, after changing the probes, 
alignment should be reviewed. To check the current alignment and make 
adjustments as needed, select the Adjust X&Y tab.

The X offset and Y offset text boxes display the current offsets stored in the 
instrument’s memory.

To determine if the probes need to be adjusted in the X or Y direction, select the 
model of the injection module that is on your Multiple Probe 215 Liquid Handler 
(likely an 849 Injection Module) or select other for a user-defined test point. The 
default X,Y coordinates are shown next to the model number.

Transport the Liquid Handler

When moving the liquid handler to another location or when sending it in for 
service, do not use the Y-arm as a handle. Reinstall the armlock (see page 2-3) and 
always lift the liquid handler from the base.

Injection Module Coordinates

849:
X-coordinate: 336.1 mm
Y-coordinate: 3.8 mm

other:
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Troubleshooting 5

This chapter provides information on the following topics:

• Error Messages

• Mechanical

• Electrical

• Tubing and Syringe Pump

• Repair and Return Policies
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Error Description Solution

10 Invalid Pump Type Run the 215 Setup Utility to correct the problem.

11 Undefined syringe size Run the 215 Setup Utility to correct the problem.

12 Pump not found Contact your Gilson-authorized representative.

13 Syringe speed out of range This can be caused by an incorrect syringe size 
setting. Run the 215 Setup Utility (Syringe Options 
tab) to check that the correct syringe capacity was 
selected. If you do not know the size of the syringe 
installed, check the container the syringe was 
shipped in for size information.

Or, the requested aspirate or dispense speed is too 
fast for the installed syringe. Refer to the table 
listing the maximum flow rates on page 1-9 and 
then change the speed accordingly in the control 
software.

14 Invalid syringe volume Requested aspirate or dispense volume is too 
large for syringe installed. Modify the syringe 
aspirate and dispense volumes in the program 
controlling the liquid handler. An incorrect syringe 
size setting can also cause improper volumes to be 
aspirated or dispensed during operation or can 
cause an error to occur. Run the 215 Setup Utility 
(Syringe Options tab) to check that the correct 
syringe capacity was selected.

15 NV-RAM checksum is invalid • Send the buffered ~9 GSIOC command to 
reset the NV-RAM and initialize to the 
default value. Run the 215 Setup Utility.

• Replace the main board.

16 X scale factor is invalid Contact your Gilson-authorized representative.

17 Y scale factor is invalid Contact your Gilson-authorized representative.

18 Z scale factor is invalid Contact your Gilson-authorized representative.

20 X motor position error Turn power on/off to the liquid handler.

21 Y motor position error Turn power on/off to the liquid handler.
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22 Z motor position error Turn power on/off to the liquid handler.

24 X target less than minimum X Send the immediate Q command using the 
GSIOC Utility to read the travel range. Correct the 
error in the program controlling the liquid handler.

25 X target more than maximum X Send the immediate Q command using the 
GSIOC Utility to read the travel range. Correct the 
error in the program controlling the liquid handler.

26 Y target less than minimum Y Send the immediate Q command using the 
GSIOC Utility to read the travel range. Correct the 
error in the program controlling the liquid handler.

27 Y target more than maximum Y Send the immediate Q command using the 
GSIOC Utility to read the travel range. Correct the 
error in the program controlling the liquid handler.

28 Z target less than minimum Z Send the immediate Q command using the 
GSIOC Utility to read the travel range. Correct the 
error in the program controlling the liquid handler.

29 Z target more than maximum Z Send the immediate Q command using the 
GSIOC Utility to read the travel range. Correct the 
error in the program controlling the liquid handler.

30 X encoder inactive Contact your Gilson-authorized representative.

31 Y encoder inactive Contact your Gilson-authorized representative.

32 Z position sensor inactive Contact your Gilson-authorized representative.

33 Safety contact activated Release contact; restart.

34 X home phase is invalid Run the 215 Setup Utility to correct the problem.

35 Y home phase is invalid Run the 215 Setup Utility to correct the problem.

36 X and Y home phases are invalid Run the 215 Setup Utility to correct the problem.

40 Gilson m402 invalid valve position This is caused by the valve stem not turning 
properly or the encoder not registering properly. 
Try operating without a valve. If that fails, you will 
probably need a new module. If that works, check 
the valve assembly for smooth operation. If 
necessary, replace valve.

Error Description Solution
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41 Gilson m402 valve missing Contact your Gilson-authorized representative.

42 Gilson m402 undefined valve command Try operating without a valve. If that fails, you will 
probably need a new module. If that works, check 
the valve assembly for smooth operation. If 
necessary, replace valve.

43 Gilson m402 valve communication error Try operating without a valve. If that fails, you will 
probably need a new module. If that works, check 
the valve assembly for smooth operation. If 
necessary, replace valve.

44 Gilson m402 valve unit busy Try operating without a valve. If that fails, you will 
probably need a new module. If that works, check 
the valve assembly for smooth operation. If 
necessary, replace valve.

45 Gilson m402 syringe overload • Slow down flow rate indicated for aspirate 
and dispense commands in the program 
controlling the liquid handler.

• Use less viscous liquid.

• Use larger ID transfer tubing.

46 Gilson m402 syringe missing Try operating without a valve. If that fails, you will 
probably need a new module. If that works, check 
the valve assembly for smooth operation. If 
necessary, replace valve.

47 Gilson m402 undefined syringe command Try operating without a valve. If that fails, you will 
probably need a new module. If that works, check 
the valve assembly for smooth operation. If 
necessary, replace valve.

48 Gilson m402 syringe communication error Replace the syringe pump.

49 Gilson m402 syringe unit busy Replace the syringe pump.

Error Description Solution
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Probe No Longer Finding Tube Center

• Probe may be bent. Straighten or replace the probe.

• Liquid handler may be misaligned. Perform the position alignment 
procedures, described on page 4-13.
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Input Functions Not Operating

• Make sure connections into the terminal block connector are secure.

• Make sure the terminal block connector is secure in the input/output ports.

• Check connections for proper pin assignments.

• Be sure pins from external devices are assigned correctly.

• Check polarity of input. Inputs should be a contact closure. If not, it must be 
TTL level (logic 0 activates).

• Confirm that source supplying input to the liquid handler is working.

Output Functions Not Operating

• Make sure connections into the terminal block connector are secure.

• Make sure the terminal block connector is secure in the input/output ports.

• Check connections for proper pin assignments.

• Output from the liquid handler should be compatible with the device to 
which it is interfaced. Outputs are contact closures.

Unit Not Operational

• Make sure power is turned on.

• Check power cord connections.

• Try different outlet.

• Check fuse(s); replace if necessary.

• Check all liquid handler connections and make sure that the unit is plugged in.

Unit Blows Fuses

A blown fuse may indicate the existence of another problem in the instrument. If 
the replacement fuses blow, do not try others. Contact your Gilson-authorized 
representative. See Before Calling Us on page 5-9.



Gilson Multiple Probe 215 Liquid Handler 5-7

Troubleshooting 5
Tu

b
in

g
 an

d
 Syrin

g
e P

u
m

p

Tubing and Syringe Pump

Instrument Will Not Draw in Reagent

• Make certain all fittings are tight.

• Check valve fitting threads on the syringe pump. Replace if damaged.

No Fluid Being Dispensed

• Make sure the syringe is tight in the valve fitting.

• If tubing is kinked or blocked, replace defective tubing.

• Replace solenoid valve if damaged. Turn the power to the liquid handler off 
and then on to re-initialize.

Reagent Being Pulled Back Into Reservoir

• Replace solenoid valve if damaged. Turn the power to the liquid handler off 
and then on to re-initialize.

Air Gap Breaks Up

• When aspirating a liquid, if the air gap breaks up, check to see if the tubing is 
the correct size.

• Reduce speed of aspiration.

• Increase size of air gap.

• Clean or replace any dirty tubing.

Syringe Bubbles

• Make sure that all tubing fittings are tight and air-free.

• Make sure the syringe is tightened into the valve retainer block.

• Clean the syringe if dirty. Refer to Clean a Syringe on page 4-3.

• If any of the valve fittings are damaged, replace the valve.
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• Make sure fittings are tight.

• Replace any worn piston seals on the syringe piston. Instructions are 
supplied with replacement seals. (Condensation within a syringe indicates a 
worn piston seal.)

• Allow reagents to warm to room temperature before using.

Incorrect Aspirating and Dispensing

• Check for leaks on all fittings and tubing leading to the probes.

• Tighten or replace fittings on inlet and transfer tubing as needed.

• Replace solenoid valve if damaged. Turn the power to the liquid handler off 
and then on to re-initialize.

Syringe Stalls

• If the syringe on the syringe pump stalls, there may be a blockage in the 
tubing or valve. Inspect all tubing and the valve. 

• If the syringe stalls due to an accelerated aspirate or dispense flow rate, 
reduce the flow rate in the program controlling the liquid handler.

Poor Accuracy

• Worn piston seals and tubing can cause the liquid handler to perform with 
poor volumetric accuracy and precision. Inspect seals and tubing and 
replace if necessary. (Condensation within a syringe indicates a worn piston 
seal.)

• If the aspirate and dispense flow rates are too fast, slow down the flow rates 
to adapt to the tubing and probe type.
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Repair and Return Policies

Before Calling Us

Gilson-authorized representatives will be able to serve you more efficiently if you 
have the following information:

• the serial number and model number of the instruments involved. The serial 
number is visible on the inside right support of the liquid handler. 

• the installation procedure you used

• list of concise symptoms

• list of operating procedures and conditions you were using when the 
problem arose

• list of other devices connected to the liquid handler and a description of 
those connections

• list of other electrical connections in the room

Warranty Repair

Units covered under warranty will be repaired and returned to you at no charge. 
If you have any questions about applicability, please contact your local 
distributor.

Non-Warranty Repair

For out-of-warranty repairs, contact your local distributor. A Customer Service 
representative will discuss service options with you and can assist in making 
arrangements to return the equipment, if necessary.

Rebuilt Exchange

For some units, rebuilt exchange components are available. Contact your local 
distributor for details.
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Contact your local distributor’s Customer Service Department to obtain 
authorization before returning any Gilson equipment. To return a piece of 
equipment:

• Carefully pack the unit to prevent damage in transit. Check with your 
distributor regarding proper method of shipment. No responsibility is 
assumed by Gilson or your distributor for damage caused by improperly 
packaged instruments. Indicate the authorization on the carton and on the 
packing slip.

• Always insure for the replacement value of the unit.

• Include a description of symptoms, your name, address, phone number, and 
purchase order to cover repair costs, return and shipping charges, if your 
institution requires it. 

Unit End-of-Life

When a unit reaches the end of its useful life, refer to www.gilson.com 
for directions and information on the end-of-life policy. This is in 
accordance with the European Union Directive 2002/96/EC on Waste 
Electrical and Electronic Equipment (WEEE).
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Part Number Description

25101311 MULTIPLE PROBE 215 W/125MM Z DRIVE

Probe/Injection Port Compatibility Chart for the Multiple Probe 215 Injector 
(with 849 Multiple Injection Module)

Probe

Injection Port Bar

Z-Arm Probe Holder/ 
Guide Kit0.7 mm 

250512861
1.3 mm 

250512862
1.5 mm 

250512863

27067377 X 125 mm 253652

27067361 X 125 mm 253652

27067373 X 125 mm 253652

2507414 X 125 mm 253651

27067374 X 125 mm 253652

2507252 X 125 mm 253652

2507215 X 175 mm 253651

25073645 X 175 mm 253651
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Probes for 125 mm Z-Arm

Part Number Description

27067361

Non septum-piercing probe; bevel tip, capacitive level-sensing, stainless steel. 
Dimensions: 220.5 x 1.5 x 1.1 mm ID. Compatible with 849 Multiple Injection Module; 
requires injection port bar (part number 250512753 for the 889 or part number 
250512863 for the 849). Requires probe holder/guide kit (part number 253652).

2507414

Non septum-piercing probe; constricted tip, capacitive level-sensing, stainless steel. 
Dimensions: 220 x 1.3 x 0.8 mm ID (tip dimensions: 1.5 x 0.9 x 0.45 mm ID). Compatible 
with 849 Multiple Injection Module; requires injection port bar (part number 250512752 
for the 889 or part number 250512862 for the 849). Requires probe holder/guide kit 
(part number 253651).

27067373

Non septum-piercing probe; constricted tip, capacitive level-sensing, stainless steel. 
Dimensions: 221 x 1.5 x 1.1 mm ID (tip dimensions: 2 x 1.1 x 0.4 mm ID). Compatible with 
849 Multiple Injection Module; requires injection port bar (part number 250512753 for 
the 889 or part number 250512863 for the 849). Requires probe holder/guide kit 
(part number 253652).

27067374

Non septum-piercing probe; constricted bevel tip, capacitive level-sensing, stainless 
steel. Dimensions: 221 x 1.5 x 1.1 mm ID (tip dimensions: 2 x 1.1 x 0.4 mm ID). Compatible 
with 849 Multiple Injection Module; requires injection port bar (part number 250512753 
for the 889 or part number 250512863 for the 849). Requires probe holder/guide kit 
(part number 253652).

2507252

Micro septum-piercing probe; constricted 45° bevel tip, capacitive level-sensing, 
stainless steel. Dimensions: 221.5 x 1.5 x 1.1 mm ID (tip dimensions: 10 x 0.7 x 0.4 mm 
ID). Compatible with 849 Multiple Injection Module; requires injection port bar 
(part number 250512751 for the 889 or part number 250512861 for the 849). Requires 
probe holder/guide kit (part number 253652).

27067377

Grooved septum-piercing probe; beveled-tip, stainless steel. Dimensions: 221 x 1.5 x 0.4 
mm ID. Compatible with 849 Multiple Injection Module; requires injection port bar 
(part number 250512753 for the 889 or part number 250512863 for the 849). Requires 
probe holder/guide kit (part number 253652).

27067375
Non-septum-piercing probe: beveled-tip, Teflon-coated stainless steel. Dimensions: 
221 x 1.5 x 1.1 mm ID. Requires probe holder/guide kit (part number 253652).
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Probes for 175 mm Z-Arm

Probe Holder/Guide Kits

Part Number Description

2507215

Non septum-piercing probe; constricted tip, capacitive level-sensing, stainless steel. 
Dimensions: 269 x 1.3 x 0.8 mm ID (tip dimensions: 1.5 x 0.9 x 0.45 mm ID). Compatible 
with 849 Multiple Injection Module; requires injection port bar (part number 250512752 
for the 889 or part number 250512862 for the 849). Requires probe holder/guide kit 
(part number 253651).

25073645

Non septum-piercing probe; beveled tip, capacitive level-sensing, stainless steel. 
Dimensions: 269 x 1.3 x 0.8 mm ID. Compatible with 849 Multiple Injection Module; 
requires injection port bar (part number 250512752 for the 889 or part number 
250512862 for the 849). Requires probe holder/guide kit (part number 253651).

Part Number Description

253651
Probe holder/guide kit; includes probe holder and guide for 1.3 mm outer diameter 
probes.

253652
Probe holder/guide kit; includes probe holder and guide for 1.5 mm outer diameter 
probes.
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Rinse Station

Part Number Description

25053146 100 μL syringe

25053147 250 μL syringe

25053148 500 μL syringe

25053141 1 mL syringe

25053143 2.5 mL syringe

25053145 5 mL syringe

499421202 1.5 mL FEP tubing; 0.8 mm ID x 10 feet

25053173
1.5 mL Teflon transfer tubing assembly, 0.8 mm ID; for use with 100 μL, 250 μL, 500 μL 
and 1 mL syringes on the Multiple Probe 215. Includes eight bundled and labeled 
lengths of transfer tubing and fittings.

499471112 5.5 mL FEP tubing; 1.5 mm ID x 9.27 feet; with Omnifit 1/4"-28 fittings

25053174
5.5 mL Teflon transfer tubing assembly, 1.5 mm ID; for use with 2.5 mL and 5 mL syringes 
on the Multiple Probe 215. Includes eight lengths of bundled and labeled transfer 
tubing.

F1410050 PVDF coupling for 1/4"-28 fitting, package of 5

25053172 Waste bottle (8 liter) with lid and quick-connect fitting

470343706
Tygon tubing (5/16" ID x 7/16" OD) for connection between rinse station and waste 
bottle; per foot

23077332 Quick-connect fitting to connect Tygon tubing to waste bottle

Part Number Description

25045525 Multiple Probe 215 rinse station; connects to rinse station base

25245512 Rinse station base; attaches directly to 215 locator plate
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Racks

For part numbers for available racks, refer to Appendix B, Racks. To create your 
own code 200-style rack, order the blank rack kit (part number 254461) and 
rivet gun (part number 4391002).

Cables and I/O Accessories

Miscellaneous

Part Number Description

36083121 Serial cable, IBM PS/2-type, 25 to 25 pin

36083122 Serial cable, IBM AT-type, 9-pin female to 25-pin male

36083123 Serial cable adapter, 9-pin female to 25-pin male

638308512 Terminal block connector, 8-pin

638310512 Terminal block connector, 10-pin

709910206 2-conductor interconnect wire, 6' for making contact connections

36078143 Shielded GSIOC cable, 30"

6730254007 2.5A, T-2.5 Slo-Blo fuse

Part Number Description

23077333 Y-connector to connect two rinse stations to one waste bottle

2509211 Armlock with hex screw

4311403 9/64" ball driver (hex wrench for armlock)

54118025 Spiral wrap
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This appendix describes the racks that can be purchased for use on the Multiple Probe 215 
Liquid Handler.
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For two microplates, two microcentrifuge tubes, and two 
13x100 mm tubes

Material: aluminum

Vessels and maximum capacity: 96 well microplates

microcentrifuge tubes (1.5 mL)

13 x 100 mm tubes (9 mL)

Part Number: 2504601

Code 201H rack
For two microplates, two Eppendorf vials, and two 13 x 100 
mm tubes; with microplate covers

Material: aluminum

Vessels and maximum capacity: 96-well microplates

Eppendorf vials (1.5 mL)

13 x 100 mm tubes (9 mL)

Part Number: 2504601H
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Code 205 rack
For two deep-well microplates, two microcentrifuge tubes, 
and two 13 x 100 mm tubes

Material: aluminum

Vessels and maximum capacity: 96 deep-well microplates

Eppendorf vials (1.5 mL)

13 x 100 mm tubes (9 mL)

Part Number: 2504605

Code 205H rack
For two deep-well microplates, two Eppendorf vials, and two 
13 x 100 mm tubes; with microplate covers

Material: aluminum

Vessels and maximum capacity: 96 deep-well microplates

Eppendorf vials (1.5 mL)

13 x 100 mm tubes (9 mL)

Part Number: 2504605H
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For 96 tubes

Material: aluminum

Vessels and maximum capacity: 96 10 x 75 mm (3.5 mL) culture 
tubes

Part number: 2504617

Note: The zigzag pattern allows all eight probes to draw 
from one row of test tubes.

Code 218 rack
For two microplates and eight 10 x 75 culture tubes 

Material: aluminum

Vessels and maximum capacity: two 96-well microplates and 
eight 10 x 75 mm culture tubes (3.5 mL)

Part number: 2504618

Note: Instead of microplate(s), you can install Beckman 
modular reservoirs.

Code 228 rack
For 27 conical bottom tubes

Material: aluminum

Vessels and maximum capacity: 27 (50 mL)

Part Number: 2504622



Gilson Multiple Probe 215 Liquid Handler B-5

Appendix B
R

acks

Code 505 rack
For 10 standard or deep-well microplates

Material: aluminum

Part Number: 2504651

Code 505H rack
For 10 standard or deep-well microplates with hold-down 
covers

Material: aluminum

Part Number: 2504651H
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The GSIOC Configuration Editor enables you to modify COM (serial communications) port and baud rate 
information. Or, you can use this editor if incorrect information appears in the GSIOC Utility window.

1 Locate the GSIOC Configuration Editor (GSCONFIG.EXE) using Windows Explorer or the shortcut at 
Start—Programs—Gilson Applications—Utilities—GSIOC Configuration Editor. During 
installation, this editor was stored to C:\GILSON\UTIL unless the installation path was changed.

2 Start the editor. The GSIOC Configuration Editor window appears.

3 In the Port box, indicate the computer’s serial communications port (COM) port to which the Gilson 
interface instrument (such as the liquid handler or 506C System Interface) is connected.

4 Click 19200 or 9600 to select the baud. The baud is the rate of data transmission between the 
computer and the Gilson instrument.

5 Click OK to save the changes. A message box appears indicating that the computer must be restarted 
before any changes become effective.
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GSIOC Utility D

The GSIOC Utility allows you to issue commands to Gilson GSIOC instruments. Your Gilson-authorized 
representative may ask you to use this utility to verify that an instrument is connected correctly to the 
computer. For communication to occur, the Gilson instrument must be connected via an RS-232 
connection to the computer or connected via a GSIOC connection to a Gilson interface instrument that 
is connected to the computer.
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1 Locate the GSIOC Utility (GSUTIL32.EXE) using Windows Explorer or the 
shortcut at Start > (All) Programs > Gilson Applications > Utilities > 
GSIOC Utility. During installation, this utility was stored to C:\GILSON\UTIL 
unless the installation path was changed.

2 Start the utility. The GSIOC Utility window appears.

Review the Port and Baud Information

In the GSIOC Utility window, review the COM port and baud information. If any 
information is incorrect or missing, close the GSIOC Utility and use the GSIOC 
Configuration Editor to update the information. Refer to Appendix C, GSIOC 
Configuration Editor.

Listing GSIOC Instruments

Using the GSIOC Utility, you can determine the instruments currently connected 
to the computer.

In the Mode menu, select Scan!

The Unit ID list box displays the unit IDs and the version of the connected 
instruments. If any connected instruments are missing from the list, ensure that 
the proper RS-232 or GSIOC connection exists between the computer and the 
instruments, and that the instruments do not have duplicate unit ID numbers.
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Basic Mode

In the Basic mode, immediate and buffered GSIOC commands can be sent to 
specific Gilson instruments.

Review the Port, IRQ, and Baud information in this window. If any information is 
incorrect or missing, close the GSIOC Utility and use the GSIOC Configuration 
Editor to update the information.

There are two drop-down menus in the Basic mode of the Gilson GSIOC Utility: 
Mode Menu and Help Menu.

Basic Mode Buttons and Features

Immediate Button

Sends an immediate command to the Unit ID selected.

Immediate commands request status information from an instrument. These 
commands are executed immediately, temporarily interrupting any command in 
progress. 

You can find a list of valid immediate commands for each instrument in its 
commands list or user’s guide.

Buffered Button

Sends a buffered command to the Unit ID selected.

Buffered commands send instructions to an instrument. These commands are 
executed one at a time. 

You can find a list of valid buffered commands for each instrument in its 
commands list or user’s guide.

Command Field

Where the command to be sent is specified. For more information on sending 
commands, see Send an Immediate Command on page D-16 or Send a 
Buffered Command on page D-16.



Appendix D

D-4 Gilson Multiple Probe 215 Liquid Handler

G
SI

O
C

 U
ti

lit
y Response Field

Returns a response to an immediate or buffered command.

The response to a successfully completed buffered command is “ok”.

Refer to the user’s guide for the Gilson instrument for a description of the valid 
response to immediate commands.

The response to an unsuccessfully completed immediate or buffered command 
is “#error”.

Basic Mode Menus

Mode Menu

There are three options in the Mode menu: Scan!, Advanced, and Ghost.

Scan!

The Scan! option on the Mode menu allows you to 
scan for GSIOC instruments. After a scan, the Unit ID 
list box displays the unit IDs and the version of the 
connected instruments. If any connected 
instruments are missing from the list, ensure that the proper RS-232 or GSIOC 
connection exists between the computer and the instruments, and that the 
instruments do not have duplicate Unit ID numbers.

Advanced

The advanced option in the Mode menu allows you to switch 
between the Basic and Advanced modes. A check mark 
means that the GSIOC Utility is in Advanced mode.

Ghost

The Ghost option in the Mode menu makes the GSIOC Utility window 
transparent (and always on top). This allows you to view another window behind 
the Utility. The Utility will remain fully functional in the Ghost mode.
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Help Menu

Help Topics

When selected, the Help window for the Gilson GSIOC Utility appears.

About

When selected, the About window appears.

This window displays the version of the Gilson GSIOC Utility, the GSIOC32.DLL, 
and the GSIOC Server or Driver; and the Port, IRQ, and Baud set by the GSIOC 
Configuration Editor.
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In the Advanced mode, immediate and buffered GSIOC commands can be sent 
to specific Gilson instruments. In this mode, immediate and buffered commands 
with comments can be saved to a command list to be used as needed. The 
command lines can be repeated automatically to monitor the status of the 
instrument.

Review the Port, IRQ, and Baud information by selecting About... from the Help 
menu. If any information is incorrect or missing, close the GSIOC Utility and use 
the GSIOC Configuration Editor to update the information.

There are four drop-down menus in the Advanced mode of the Gilson GSIOC 
Utility: File Menu, Edit Menu, Mode Menu, and Help Menu.
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Advanced Mode Buttons and Features

+ Button

The  next to  is used to insert an immediate command in the 

command list. For more information, see Insert an Immediate Command on 
page D-14.

The  next to  is used to insert a buffered command in the 

command list. For more information, see Insert a Buffered Command on 
page D-15.

Arrow Up or Arrow Down Button

These buttons (  or ) are used to change the position of a command in 

the command list.

To move a command

Highlight the command in the command list and use  to move the 

command up in the list or  to move the command down in the list.

Immediate Button

Sends an immediate command to the Unit ID selected. The Comment field is not 
used.

Selecting the Immediate button will not add the command to the command list.

For more information, see Send an Immediate Command on page D-16.

Buffered Button

Sends a buffered command to the Unit ID selected. The Comment field is not 
used.

Selecting the Buffered button will not add the command to the command list.

For more information, see Send a Buffered Command on page D-16.
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Returns a response to an immediate or buffered command.

The response will become gray after 15 seconds if no response is registered.

The response to a successfully completed buffered command is “ok”.

Refer to the user’s guide for the Gilson instrument for a description of the valid 
response to the immediate commands.

The response to an unsuccessfully completed immediate or buffered command 
is “#error”.

To send a command line

Double-click on the Unit, Type, Command, Response, or Comment field to send 
the immediate or buffered command for that specific command line.
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Command Line Column Headings

Repeat

A green check mark ( ) in the Repeat column means that an immediate 
command will automatically repeat when the Auto Repeat option is checked. 
Double-click on the Repeat field to select or deselect the Auto Repeat for that 
command line.

A yellow check mark ( ) in the Repeat column means that a buffered command 
will automatically repeat when the Auto Repeat option is checked. Double-click 
on the Repeat field to select or deselect the Auto Repeat option for that 
command line.

Unit

This is the Unit ID for the instrument in the command line.

Type

I - Immediate Command, B - Buffered Command

Command

This is the GSIOC command for the command line.

Response

This is the GSIOC response when the command line is initiated with a 
double-click on the Unit, Type, Command, Response, or Comment field. The 
response will become gray after 15 seconds if no response is registered.

Comment

This is an optional comment that can be added to the command line.
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File Menu

There are four options in the File menu: Open, Save, Save As..., and Exit.

Open

The Open option in the File menu allows you to open previously created 
command lists (GSUTIL32 files). The extension for a GSUTIL32 file is .GSU.

Save

The save option in the File menu allows you to save the Advanced commands to 
GSUTIL32.GSU. The GSUTIL32.GSU file is automatically created in the location 
where GSUTIL32.EXE is stored.

The Advanced commands will automatically be saved to GSUTIL32.GSU if the 
Gilson GSIOC Utility is exited without saving.

The GSUTIL32. GSU is automatically opened when the Advanced mode is 
selected from the Mode menu.

Save As...

The Save As... option on the File menu allows you to save the Gilson GSIOC Utility 
commands that are currently defined. The file’s name and path must be specified.

Exit

Closes the Gilson GSIOC Utility software.

Edit Menu

There are four options in the Edit Menu: Insert Immediate, Insert Buffered, 
Selection, and Font....

Insert Immediate

The Insert Immediate option in the Edit menu allows you to insert an immediate 
command in the command list. The new command will be added to the last line 
in the command list.
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The GSIOC Command will not be inserted if there is already a command line in 
the list with the same Unit ID and Command.

For more information, see Insert an Immediate Command on page D-14.

Insert Buffered

The Insert Buffered option in the Edit menu allows you to insert a buffered 
command in the command list. The new command will be added to the last line 
in the command list.

The GSIOC Command will not be inserted if there is already a command line in 
the list with the same Unit ID and Command.

For more information, see Insert a Buffered Command on page D-15.

Selection

Delete (Ctrl + D)

Deletes the highlighted command from the command list.

Up (Ctrl + U)

Moves the highlighted command up in the command list.

Down (Ctrl + D)

Moves the highlighted command down in the command list.

Execute (Ctrl + E)

Executes the highlighted command.

Repeat (Ctrl + R)

Adds or removes the repeat option for the highlighted command.
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The Font... option on the Edit menu allows you to change the font options for the 
command list fields and headers, as well as the Unit ID, Comment, and Command 
text boxes.

Mode Menu

There are four options in the Mode menu: Scan!, Advanced, Auto Repeat, and 
Ghost.

Scan!

The Scan! option on the Mode menu allows you to 
scan for GSIOC instruments. After a scan, the Unit ID 
list box displays the unit IDs and the version of the 
connected instruments. If any connected 
instruments are missing from the list, ensure that the proper RS-232 or GSIOC 
connection exists between the computer and the instruments, and that the 
instruments do not have duplicate Unit ID numbers.

Advanced

The advanced option in the Mode menu allows you to switch 
between the Basic and Advanced modes. A check mark 
means that the GSIOC Utility is in Advanced mode.

Auto Repeat

The Auto Repeat option on the Mode menu allows you to repeat command lines 
that appear in the command list.

A command line will only repeat if a check mark appears in the Repeat field. A 
check mark can be added by double-clicking on the Repeat field and selecting 
the Auto Repeat check box.

Starting from the top command line, this mode will refresh one repeating 
command line every 1/10th of a second. For example, if there are ten command 
lines with Repeat selected, each of these command lines will be initiated every 
second.

Auto Repeat mode is useful for monitoring the instrument using immediate 
commands and is designated in the Repeat field with a green check mark.
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Auto Repeat mode is not intended to be used as a programming tool with 
buffered commands. Repeating buffered commands will be executed at a fixed 
time interval regardless if a command has finished. For this reason, the check 
mark in the buffered command line is yellow.

Auto Repeat mode can be selected from the Mode menu or by selecting the 
check box next to Auto Repeat.

Auto Repeat is deselected by default with the Advanced mode is first opened. 
When Gilson GSIOC Utility - Advanced is saved or closed, the status of Auto 
Repeat is saved.

Ghost

The Ghost option in the Mode menu makes the GSIOC Utility window 
transparent (and always on top). This allows you to view another window behind 
the Utility. The Utility will remain fully functional in the Ghost mode.

Help Menu

Help Topics

When selected, the Help window for the Gilson GSIOC Utility appears.

About

When selected, the About window appears.

This window displays the version of the Gilson GSIOC Utility, the GSIOC32.DLL, 
and the GSIOC Server or Driver; and the Port, IRQ, and Baud set by the GSIOC 
Configuration Editor.
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Immediate Command

Immediate commands request status information from an instrument. These 
commands are executed immediately, temporarily interrupting any command in 
progress. 

You can find a list of valid immediate commands for each instrument in its 
commands list or user’s guide.

Buffered Command

Buffered commands send instructions to an instrument. These commands are 
executed one at a time. 

You can find a list of valid buffered commands for each instrument in its 
commands list or user’s guide.

Insert an Immediate Command

There are two ways to insert an immediate command in Advanced mode.

Using the Edit Menu

1 From the Unit ID drop-down box, select the unit ID of the instrument to send 
the command to.

2 Type a Command and Comment. (The comment is optional.)

3 Select Insert Immediate from the Edit menu. The new command will be 
inserted at the bottom of the command list.

Note: The command will not be inserted if there is already a command line in the 
list with the same Unit ID and command.
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Using the + Button

1 From the Unit ID drop-down box, select the unit ID 
of the instrument to send the command to.

2 Type a Command and Comment. (The comment is 
optional.)

3 Click the  button next to the Immediate 
button. The new command will be inserted at the bottom of the command 
list.

Note: The command will not be inserted if there is already a command line in the 
list with the same Unit ID and command.

Insert a Buffered Command

There are two ways to insert a buffered command in Advanced mode.

Using the Edit Menu

1 From the Unit ID drop-down box, select the unit ID of the instrument to send 
the command to.

2 Type a Command and Comment. (The comment is optional.)

3 Select Insert Immediate from the Edit menu. The new command will be 
inserted at the bottom of the command list.

Note: The command will not be inserted if there is already a command line in the 
list with the same Unit ID and command.

Using the + Button

1 From the Unit ID drop-down box, select the unit ID of the instrument to send 
the command to.

2 Type a Command and Comment. (The comment is optional.)

3 Click the  button next to the Buffered button. 
The new command will be inserted at the bottom of 
the command list.

Note: The command will not be inserted if there is 
already a command line in the list with the same Unit ID 
and command.
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Basic Mode

1 From the Unit ID drop-down box, select the unit ID of the instrument to send 
the command to.

2 Type (or select) a Command.

3 Click .

Advanced Mode

Using the  button

1 From the Unit ID drop-down box, select the unit ID of the instrument to send 
the command to.

2 Type a Command and Comment. (The comment is optional.)

3 Click .

Using Execute from the Edit menu

1 Highlight the command to be sent in the command list.

2 Choose Selection from the Edit menu and select Execute. (Or, type Ctrl + E.)

Using the command list

Double-click on the command line of the command you want to send.

Send a Buffered Command

Basic Mode

1 From the Unit ID drop-down box, select the unit ID of the instrument to send 
the command to.

2 Type (or select) a Command.

3 Click .

Advanced Mode

Using the  button

1 From the Unit ID drop-down box, select the unit ID of the instrument to send 
the command to.

2 Type a Command and Comment. (The comment is optional.)

3 Click .



Gilson Multiple Probe 215 Liquid Handler D-17

Appendix D
G

SIO
C

 U
tility

Using Execute from the Edit menu

1 Highlight the command to be sent in the command list.

2 Choose Selection from the Edit menu and select Execute. (Or, type Ctrl + E.)

Using the command list

Double-click on the command line of the command you want to send.
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